


14–2 Chapter 14: Design Debugging Using the SignalTap II Embedded Logic Analyzer
Introduction
This chapter is intended for any designer who wants to debug their FPGA design 
during normal device operation without the need for external lab equipment. Because 
the SignalTap II Embedded Logic Analyzer is similar to traditional external logic 
analyzers, familiarity with external logic analyzer operations is helpful but not 
necessary. To take advantage of faster compile times when making changes to the 
SignalTap II Embedded Logic Analyzer, knowledge of the Quartus II incremental 
compilation feature is helpful.

f For information about using the Quartus II incremental compilation feature, refer to 
the Quartus II Incremental Compilation for Hierarchical and Team-Based Design chapter in 
volume 1 of the Quartus II Handbook.

Hardware and Software Requirements
The following components are required to perform logic analysis with the 
SignalTap II Embedded Logic Analyzer:

■ Quartus II design software

or
Quartus II Web Edition (with the TalkBack feature enabled)
or
SignalTap II Embedded Logic Analyzer standalone software

■ Download/upload cable

■ Altera® development kit or user design board with JTAG connection to device 
under test

Figure 14–1. SignalTap II Embedded Logic Analyzer Block Diagram (Note 1)

Note to Figure 14–1:
(1) This diagram assumes that the SignalTap II Embedded Logic Analyzer was compiled with the design as a separate design partition using the 

Quartus II incremental compilation feature. This is the default setting for new projects in the Quartus II software. If incremental compilation is 
disabled or not used, the SignalTap II logic is integrated with the design. For information about the use of incremental compilation with 
SignalTap II, refer to “Faster Compilations with Quartus II Incremental Compilation” on page 14–53.
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Introduction
1 The Quartus II software Web Edition does not support the SignalTap II 
Embedded Logic Analyzer with the incremental compilation feature.

Captured data is stored in the device’s memory blocks and transferred to the 
Quartus II software waveform display with a JTAG communication cable, such as 
EthernetBlaster or USB-BlasterTM. Table 14–1 summarizes some of the features and 
benefits of the SignalTap II Embedded Logic Analyzer.

f The Quartus II software offers a portfolio of on-chip debugging solutions. For an 
overview and comparison of all of the tools available in the In-System Verification 
Tool set, refer to Section V. In-System Design Debugging.

Table 14–1. SignalTap II Features and Benefits 

Feature Benefit

Multiple logic analyzers in a single device Captures data from multiple clock domains in a design at the same time.

Multiple logic analyzers in multiple devices in 
a single JTAG chain

Simultaneously captures data from multiple devices in a JTAG chain.

Plug-In Support Easily specifies nodes, triggers, and signal mnemonics for IP, such as the 
Nios® II embedded processor.

Up to 10 basic or advanced trigger conditions 
for each analyzer instance

Enables more complex data capture commands to be sent to the logic 
analyzer, providing greater accuracy and problem isolation.

Power-Up Trigger Captures signal data for triggers that occur after device programming but 
before manually starting the logic analyzer.

State-based Triggering Flow Enables you to organize your triggering conditions to precisely define what 
your embedded logic analyzer will capture.

Incremental compilation Modifies the SignalTap II Embedded Logic Analyzer monitored signals and 
triggers without performing a full compilation, saving time.

Flexible buffer acquisition modes The buffer acquisition control allows you to precisely control the data that is 
written into the acquisition buffer. Both segmented buffers and 
non-segmented buffers with storage qualification allow you to discard data 
samples that are not relevant to the debug of your design.

MATLAB integration with included MEX 
function

Collects the SignalTap II Embedded Logic Analyzer captured data into a 
MATLAB integer matrix.

Up to 2,048 channels per logic analyzer 
instance

Samples many signals and wide bus structures.

Up to 128K samples in each device Captures a large sample set for each channel.

Fast clock frequencies Synchronous sampling of data nodes using the same clock tree driving the 
logic under test.

Resource usage estimator Provides estimate of logic and memory device resources used by 
SignalTap II Embedded Logic Analyzer configurations.

No additional cost The SignalTap II Embedded Logic Analyzer is included with a Quartus II 
subscription and with the Quartus II Web Edition (with TalkBack enabled).

Compatibility with other on-chip debugging 
utilities

The SignalTap II Embedded Logic Analyzer can be used in tandem with any 
JTAG based on-chip debugging tool, such as an in-system memory content 
editor. This ability to share the JTAG chain allows you to change signal 
values in real-time while you are running an analysis with the SignalTap II 
Embedded Logic Analyzer. 
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Design Flow Using the SignalTap II Embedded Logic Analyzer
Figure 14–2 shows a typical overall FPGA design flow for using the SignalTap II 
Embedded Logic Analyzer in your design. A SignalTap II file (.stp) is added to and 
enabled in your project, or a SignalTap II HDL function, created with the 
MegaWizard™ Plug-In Manager, is instantiated in your design. The diagram shows 
the flow of operations from initially adding the SignalTap II Embedded Logic 
Analyzer to your design to final device configuration, testing, and debugging.

SignalTap II Embedded Logic Analyzer Task Flow
To use the SignalTap II Embedded Logic Analyzer to debug your design, you perform 
a number of tasks to add, configure, and run the logic analyzer. Figure 14–3 shows a 
typical flow of the tasks you complete to debug your design. Refer to the appropriate 
section of this chapter for more information about each of these tasks.

Figure 14–2. SignalTap II FPGA Design and Debugging Flow
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Add the SignalTap II Embedded Logic Analyzer to Your Design
Create an .stp file or create a parameterized HDL instance representation of the logic 
analyzer using the MegaWizard Plug-In Manager. If you want to monitor multiple 
clock domains simultaneously, add additional instances of the logic analyzer to your 
design, limited only by the available resources in your device.

Configure the SignalTap II Embedded Logic Analyzer
After the SignalTap II Embedded Logic Analyzer is added to your design, configure it 
to monitor the signals you want. You can manually add signals or use a plug-in, such 
as the Nios II embedded processor plug-in, to quickly add entire sets of associated 
signals for a particular intellectual property (IP). You can also specify settings for the 
data capture buffer, such as its size, the method in which data is captured and stored, 
and the device memory type to use for the buffer in devices that support memory 
type selection.

Figure 14–3. SignalTap II Embedded Logic Analyzer Task Flow 
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Define Trigger Conditions
The SignalTap II Embedded Logic Analyzer captures data continuously while it is 
running. To capture and store specific signal data, set up triggers that tell the logic 
analyzer under what conditions to stop capturing data. The SignalTap II Embedded 
Logic Analyzer lets you define trigger conditions that range from very simple, such as 
the rising edge of a single signal, to very complex, involving groups of signals, extra 
logic, and multiple conditions. Power-Up Triggers give you the ability to capture data 
from trigger events occurring immediately after the device enters user-mode after 
configuration.

Compile the Design
With the .stp file configured and trigger conditions defined, compile your project as 
usual to include the logic analyzer in your design. Because you may need to change 
monitored signal nodes or adjust trigger settings frequently during debugging, Altera 
recommends that you use the incremental compilation feature built into the 
SignalTap II Embedded Logic Analyzer, along with Quartus II incremental 
compilation, to reduce recompile times.

Program the Target Device or Devices
When you are debugging a design with the SignalTap II Embedded Logic Analyzer, 
you can program a target device directly from the .stp file without using the 
Quartus II Programmer. You can also program multiple devices with different 
designs and simultaneously debug them.

Run the SignalTap II Embedded Logic Analyzer
In normal device operation, you control the logic analyzer through the JTAG 
connection, specifying when to start looking for trigger conditions to begin capturing 
data. With Runtime or Power-Up Triggers, read and transfer the captured data from 
the on-chip buffer to the .stp file for analysis.

View, Analyze, and Use Captured Data
After you have captured data and read it into the .stp file, it is available for analysis 
and use in the debugging process. Either manually or with a plug-in, set up 
mnemonic tables to make it easier to read and interpret the captured signal data. To 
speed up debugging, use the Locate feature in the SignalTap II node list to find the 
locations of problem nodes in other tools in the Quartus II software. Save the captured 
data for later analysis, or convert it to other formats for sharing and further study.

Add the SignalTap II Embedded Logic Analyzer to Your Design
Because the SignalTap II Embedded Logic Analyzer is implemented in logic on your 
target device, it must be added to your FPGA design as another part of the design 
itself. There are two ways to generate the SignalTap II Embedded Logic Analyzer and 
add it to your design for debugging:

■ Create an .stp file and use the SignalTap II Editor to configure the details of the 
logic analyzer
Quartus II Handbook Version 9.0 Volume 3: Verification © March 2009 Altera Corporation
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or

■ Create and configure the .stp file with the MegaWizard Plug-In Manager and 
instantiate it in your design

Creating and Enabling a SignalTap II File
To create an embedded logic analyzer, use an existing .stp file or create a new file. 
After a file is created or selected, it must be enabled in the project where it is used.

Creating a SignalTap II File
The .stp file contains the SignalTap II Embedded Logic Analyzer settings and the 
captured data for viewing and analysis. To create a new .stp file, perform the 
following steps:

1. On the File menu, click New.

2. In the New dialog box, click the Other Files tab and select SignalTap II Logic 
Analyzer File.

3. Click OK.

To open an existing .stp file already associated with your project, on the Tools menu, 
click SignalTap II Logic Analyzer. You can also use this method to create a new .stp 
file if no .stp file exists for the current project.

To open an existing file, on the File menu, click Open and select an .stp file 
(Figure 14–4).
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 3: Verification



14–8 Chapter 14: Design Debugging Using the SignalTap II Embedded Logic Analyzer
Add the SignalTap II Embedded Logic Analyzer to Your Design
Enabling and Disabling a SignalTap II File for the Current Project
Whenever you save a new .stp file, the Quartus II software asks you if you want to 
enable the file for the current project. However, you can add this file manually, 
change the selected .stp file, or completely disable the logic analyzer by performing 
the following steps:

1. On the Assignments menu, click Settings. The Settings dialog box appears.

2. In the Category list, select SignalTap II Logic Analyzer. The SignalTap II Logic 
Analyzer page appears.

3. Turn on Enable SignalTap II Logic Analyzer. Turn off this option to disable the 
logic analyzer, completely removing it from your design.

4. In the SignalTap II File name box, type the name of the .stp file you want to 
include with your design, or browse to and select a file name.

5. Click OK.

Figure 14–4. SignalTap II Editor
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Embedding Multiple Analyzers in One FPGA
The SignalTap II Editor includes support for adding multiple logic analyzers using a 
single .stp file. This feature is well-suited for creating a unique logic analyzer for each 
clock domain in the design.

To create multiple analyzers, on the Edit menu, click Create Instance, or right-click in 
the Instance Manager window and click Create Instance.

You can configure each instance of the SignalTap II Embedded Logic Analyzer 
independently. The icon in the Instance Manager for the currently active instance that 
is available for configuration is highlighted by a blue box. To configure a different 
instance, double-click the icon or name of another instance in the Instance Manager.

Monitoring FPGA Resources Used by the SignalTap II Embedded Logic Analyzer
The SignalTap II Embedded Logic Analyzer has a built-in resource estimator that 
calculates the logic resources and amount of memory that each logic analyzer instance 
uses. Furthermore, because the most demanding on-chip resource for the embedded 
logic analyzer is memory usage, the resource estimator reports the ratio of total RAM 
usage in your design to the total amount of RAM available, given the results of the 
last compilation. The resource estimator provides a warning if a potential for a 
“no-fit” occurs. 

You can see resource usage of each logic analyzer instance and total resources used in 
the columns of the Instance Manager section of the SignalTap II Editor. Use this 
feature when you know that your design is running low on resources.

The logic element value reported in the resource usage estimator may vary by as 
much as 10% from the actual resource usage.

Table 14–2 shows the SignalTap II Embedded Logic Analyzer M4K memory block 
resource usage for the listed devices per signal width and sample depth.

Table 14–2. SignalTap II Embedded Logic Analyzer M4K Block Utilization for Stratix® II, Stratix, 
Stratix GX, and Cyclone® Devices (Note 1)

Signals (Width) 
Samples (Depth)

256 512 2,048 8,192

8 < 1 1 4 16

16 1 2 8 32

32 2 4 16 64

64 4 8 32 128

256 16 32 128 512

Note to Table 14–2:

(1) When you configure a SignalTap II Embedded Logic Analyzer, the Instance Manager reports an estimate of the 
memory bits and logic elements required to implement the given configuration.
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Using the MegaWizard Plug-In Manager to Create Your Embedded Logic Analyzer
You can create a SignalTap II Embedded Logic Analyzer instance by using the 
MegaWizard Plug-In Manager. The MegaWizard Plug-In Manager generates an HDL 
file that you instantiate in your design. 

1 The State-based trigger flow, the state machine debugging feature, and the storage 
qualification feature are not supported when using the MegaWizard Plug-In Manager 
to create the embedded logic analyzer. These features are described in the following 
sections:

■ “Adding Finite State Machine State Encoding Registers” on page 14–20

■ “Using the Storage Qualifier Feature” on page 14–25

■ “Custom State-Based Triggering” on page 14–38

Creating an HDL Representation Using the MegaWizard Plug-In Manager
The Quartus II software allows you to easily create your SignalTap II Embedded 
Logic Analyzer using the MegaWizard Plug-In Manager. To implement the 
SignalTap II megafunction, perform the following steps:

1. On the Tools menu, click MegaWizard Plug-In Manager. Page 1 of the 
MegaWizard Plug-In Manager appears.

2. Select Create a new custom megafunction variation.

3. Click Next. 

4. In the Installed Plug-Ins list, expand the JTAG-accessible Extensions folder and 
select SignalTap II Embedded Logic Analyzer. Select an output file type and enter 
the desired name of the SignalTap II megafunction. You can choose AHDL (.tdf), 
VHDL (.vhd), or Verilog HDL (.v) as the output file type (Figure 14–5).
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5. Click Next.

6. Configure the analyzer by specifying the Sample depth, RAM Type, Data input 
port width, Trigger levels, Trigger input port width, whether to enable an 
external Trigger in or Trigger out, whether to enable the Segmented memory 
buffer option, and whether to enable the Storage Qualifier for non-segmented 
buffers (Figure 14–6). 

For information about these settings, refer to “Configure the SignalTap II 
Embedded Logic Analyzer” on page 14–14 and “Define Triggers” on page 14–33.

Figure 14–5. Creating the SignalTap II Embedded Logic Analyzer in the MegaWizard Plug-In 
Manager 
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7. Click Next.

8. Set the Trigger level options by selecting Basic or Advanced (Figure 14–7). If you 
select Advanced for any trigger level, the next page of the MegaWizard Plug-In 
Manager displays the Advanced Trigger Condition Editor. You can configure an 
advanced trigger expression using the number of signals you specified for the 
trigger input port width.

1 You cannot define a Power-Up Trigger using the MegaWizard Plug-In 
Manager. Refer to “Define Triggers” on page 14–33 to learn how to do this 
using the .stp file.

Figure 14–6. Select Embedded Logic Analyzer Parameters 
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9. On the final page of the MegaWizard Plug-In Manager, select any additional files 
you want to create and click Finish to create an HDL representation of the 
SignalTap II Embedded Logic Analyzer.

For information about the configuration settings options in the MegaWizard Plug-In 
Manager, refer to “Configure the SignalTap II Embedded Logic Analyzer” on 
page 14–14. For information about defining triggers, refer to “Define Triggers” on 
page 14–33.

SignalTap II Megafunction Ports
Table 14–3 provides information about the SignalTap II megafunction ports.

f For the most current information about the ports and parameters for this 
megafunction, refer to the latest version of the Quartus II Help.

Figure 14–7. MegaWizard Basic and Advanced Trigger Options 

Table 14–3. SignalTap II Megafunction Ports (Part 1 of 2)

Port Name Type Required Description

acq_data_in Input No This set of signals represents signals that are monitored in the 
SignalTap II Embedded Logic Analyzer.

acq_trigger_in Input No This set of signals represents signals that are used to trigger the analyzer.
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Instantiating the SignalTap II Embedded Logic Analyzer in Your HDL
Add the code from the files that are generated by the MegaWizard Plug-In Manager 
to your design, mapping the signals in your design to the appropriate SignalTap II 
megafunction ports. You can instantiate up to 127 analyzers in your design, or as 
many as physically fit in the FPGA. Once you have instantiated the .stp file in your 
HDL file, compile your Quartus II project to fit the logic analyzer in the target FPGA.

To capture and view the data, create an .stp file from your SignalTap II HDL output 
file. To do this, on the File menu, point to Create/Update and click Create 
SignalTap II File from Design Instance(s). 

c If you make any changes to your design or the SignalTap II instance, recreate or 
update the .stp file using the Create/Update command. This ensures that the .stp file 
is always compatible with the SignalTap II instance in your design. If the .stp file is 
not compatible with the SignalTap II instance in your design, you may not be able to 
control the SignalTap II Embedded Logic Analyzer after it is programmed into your 
device.

For information about .stp file compatibility with programmed SignalTap II 
instances, refer to “Program the Target Device or Devices” on page 14–59.

Configure the SignalTap II Embedded Logic Analyzer
The .stp file provides many options for configuring instances of the logic analyzer. 
Some of the settings are similar to those found on traditional external logic analyzers. 
Other settings are unique to the SignalTap II Embedded Logic Analyzer because of 
the requirements for configuring an embedded logic analyzer. All settings give you 
the ability to configure the logic analyzer the way you want to help debug your 
design.

1 Some settings can only be adjusted when you are viewing Run-Time Trigger 
conditions instead of Power-Up Trigger conditions. To learn about Power-Up 
Triggers and viewing different trigger conditions, refer to “Creating a Power-Up 
Trigger” on page 14–49.

Assigning an Acquisition Clock
Assign a clock signal to control the acquisition of data by the SignalTap II Embedded 
Logic Analyzer. The logic analyzer samples data on every positive (rising) edge of the 
acquisition clock. The logic analyzer does not support sampling on the negative 
(falling) edge of the acquisition clock. You can use any signal in your design as the 
acquisition clock. However, for best results, Altera recommends that you use a global, 

acq_clk Input Yes This port represents the sampling clock that the SignalTap II Embedded 
Logic Analyzer uses to capture data.

trigger_in Input No This signal is used to trigger the SignalTap II Embedded Logic Analyzer.

trigger_out Output No This signal is enabled when the trigger event occurs.

storage_enable Input No This signal is used to enable a write transaction into the acquisition buffer.

Table 14–3. SignalTap II Megafunction Ports (Part 2 of 2)

Port Name Type Required Description
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non-gated clock synchronous to the signals under test for data acquisition. Using a 
gated clock as your acquisition clock can result in unexpected data that does not 
accurately reflect the behavior of your design. The Quartus II static timing analysis 
tools show the maximum acquisition clock frequency at which you can run your 
design. Refer to the Timing Analysis section of the Compilation Report to find the 
maximum frequency of the logic analyzer clock.

To assign an acquisition clock, perform the following steps:

1. In the SignalTap II Logic Analyzer window, click the Setup tab.

2. In the Signal Configuration pane, next to the Clock field, click Browse. The Node 
Finder dialog box appears.

3. From the Filter list, select SignalTap II: post-fitting
or
SignalTap II: pre-synthesis.

4. In the Named field, type the exact name of a node that you want to use as your 
sample clock, or search for a node using a partial name and wildcard characters.

5. To start the node search, click List.

6. In the Nodes Found list, select the node that represents the design’s global clock 
signal.

7. Add the selected node name to the Selected Nodes list by clicking “>” or by 
double-clicking the node name.

8. Click OK. The node is now specified as the acquisition clock in the SignalTap II 
Editor. 

If you do not assign an acquisition clock in the SignalTap II Editor, the Quartus II 
software automatically creates a clock pin called auto_stp_external_clk.

You must make a pin assignment to this pin independently from the design. Ensure 
that a clock signal in your design drives the acquisition clock.

f For information about assigning signals to pins, refer to the I/O Management chapter in 
volume 2 of the Quartus II Handbook.

Adding Signals to the SignalTap II File
While configuring the logic analyzer, add signals to the node list in the .stp file to 
select which signals in your design you want to monitor. Selected signals are also 
used to define triggers. You can assign the following two types of signals to your .stp 
file:

■ Pre-synthesis—This signal exists after design elaboration, but before any 
synthesis optimizations are done. This set of signals should reflect your Register 
Transfer Level (RTL) signals. 

■ Post-fitting—This signal exists after physical synthesis optimizations and 
place-and-route.
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1 If you are not using incremental compilation, add only pre-synthesis signals to your 
.stp file. Using pre-synthesis is particularly useful if you want to add a new node after 
you have made design changes. Source file changes appear in the Node Finder after 
an Analysis and Elaboration has been performed. On the Processing Menu, point to 
Start and click Start Analysis & Elaboration.

The Quartus II software does not limit the number of signals available for monitoring 
in the SignalTap II window waveform display. However, the number of channels 
available is directly proportional to the number of logic elements (LEs) or adaptive 
logic modules (ALMs) in the device. Therefore, there is a physical restriction on the 
number of channels that are available for monitoring. Signals shown in blue text are 
post-fit node names. Signals shown in black text are pre-synthesis node names.

After successful Analysis and Elaboration, the signals shown in red text are invalid 
signals. Unless you are certain that these signals are valid, remove them from the .stp 
file for correct operation. The SignalTap II Status Indicator also indicates if an invalid 
node name exists in the .stp file.

As a general guideline, signals can be tapped if a routing resource (row or column 
interconnects) exists to route the connection to the SignalTap II instance. For example, 
signals that exist in the I/O element (IOE) cannot be directly tapped because there are 
no direct routing resources from the signal in an IOE to a core logic element. For input 
pins, you can tap the signal that is driving a logic array block (LAB) from an IOE, or, 
for output pins, you can tap the signal from the LAB that is driving an IOE. 

When adding pre-synthesis signals, all connections made to the SignalTap II 
Embedded Logic Analyzer are made prior to synthesis. Logic and routing resources 
are allocated during recompilation to make the connection as if a change in your 
design files had been made. As such, pre-synthesis signal names for signals driving to 
and from IOEs coincide with the signal names assigned to the pin. 

In the case of post-fit signals, connections that you make to the SignalTap II 
Embedded Logic Analyzer are the signal names from the actual atoms in your post-fit 
netlist. A connection can only be made if the signals are part of the existing post-fit 
netlist and existing routing resources are available from the signal of interest to the 
SignalTap II Embedded Logic Analyzer. In the case of post-fit output signals, tap the 
COMBOUT or REGOUT signal that drives the IOE block. For post-fit input signals, 
signals driving into the core logic coincide with the signal name assigned to the pin. 

1 If you are tapping the signal from the atom that is driving an IOE, be aware that the 
signal may be inverted due to NOT-gate push back. You can check this by locating the 
signal in either the Resource Property Editor or the Technology Map Viewer. The 
Technology Map viewer and the Resource Property Editor are also helpful in finding 
post-fit node names.

f For information about cross-probing to source design file and other Quartus II 
windows, refer to the Analyzing Designs with Quartus II Netlist Viewers chapter in 
volume 1 of the Quartus II Handbook.

For more information about the use of incremental compilation with the SignalTap II 
Embedded Logic Analyzer, refer to “Faster Compilations with Quartus II Incremental 
Compilation” on page 14–53.
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Signal Preservation
Many of the RTL signals are optimized during the process of synthesis and 
place-and-route. RTL signal names frequently may not appear in the post-fit netlist 
after optimizations. For example, the compilation process can add tildes (“~”) to nets 
that are fanning out from a node, making it difficult to decipher which signal nets 
they actually represent. This can cause a problem when you use the incremental 
compilation flow with the SignalTap II Embedded Logic Analyzer. Because only 
post-fitting signals can be added to the SignalTap II Embedded Logic Analyzer in 
partitions of type post-fit, RTL signals that you want to monitor may not be available, 
preventing their usage. To avoid this issue, use synthesis attributes to preserve signals 
during synthesis and place-and-route. When the Quartus II software encounters these 
synthesis attributes, it does not perform any optimization on the specified signals, 
forcing them to continue to exist in the post-fit netlist. However, if you do this, you 
could see an increase in resource utilization or a decrease in timing performance. The 
two attributes you can use are:

■ keep—Ensures that combinational signals are not removed

■ preserve—Ensures that registers are not removed

f For more information about using these attributes, refer to the Quartus II Integrated 
Synthesis chapter in volume 1 of the Quartus II Handbook.

If you are debugging an IP core, such as the Nios II CPU or other encrypted IP, you 
might need to preserve nodes from the core to make them available for debugging 
with the SignalTap II Embedded Logic Analyzer. This is often necessary when a 
plug-in is used to add a group of signals for a particular IP. 

To prevent the Quartus II software from optimizing away debugging signals on IP 
cores, perform the following steps:

1. In the Quartus II GUI, on the Assignments menu, click Settings. 

2. In the Category list, select Analysis & Synthesis Settings. 

3. Turn on Create debugging nodes for IP cores to make these nodes available to the 
SignalTap II Embedded Logic Analyzer.

Assigning Data Signals Using the Node Finder
To assign data signals, perform the following steps:

1. Perform Analysis and Elaboration, Analysis and Synthesis, or fully compile your 
design.

2. In the SignalTap II Logic Analyzer window, click the Setup tab.

3. Double-click anywhere in the node list of the SignalTap II Editor to open the Node 
Finder dialog box.

4. In the Fitter list, select SignalTap II: pre-synthesis or SignalTap II: post-fitting. 
Only signals listed under one of these filters can be added to the SignalTap II 
node list. Signals cannot be selected from any other filters.

1 Altera recommends that you do not add a mix of pre-synthesis and post-fitting 
signals within the same partition. For more details, refer to “Using Incremental 
Compilation with the SignalTap II Embedded Logic Analyzer” on page 14–55.
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If you use incremental compilation flow with the SignalTap II Embedded Logic 
Analyzer, pre-synthesis nodes may not be connected to the SignalTap II Embedded 
Logic Analyzer if the affected partition is of the post-fit type. A critical warning is 
issued for all pre-synthesis node names that are not found in the post-fit netlist. 

1. In the Named field, type a node name, or search for a particular node by entering a 
partial node name along with wildcard characters. To start the node name search, 
click List.

2. In the Nodes Found list, select the node or bus you want to add to the .stp file.

3. Add the selected node name(s) to the Selected Nodes list by clicking “>” or by 
double-clicking the node name(s).

4. To insert the selected nodes in the .stp file, click OK. With the default colors set for 
the SignalTap II Embedded Logic Analyzer, a pre-synthesis signal in the list is 
shown in black; a post-fitting signal is shown in blue.

1 You can also drag and drop signals from the Node Finder dialog box into 
an .stp file.

Assigning Data Signals Using the Technology Map Viewer
Starting with Quartus II software version 8.0, you can easily add post-fit signal names 
that you find in the Technology map viewer. To do so, launch the Technology map 
viewer (post-fitting) after compiling your design. When you find the desired node, 
copy the node to either the active .stp file for your design or a new .stp file. 
Figure 14–8 shows the right-click menu for adding a node using the Technology map 
viewer. 

Figure 14–8. Finding Data Signals Using the Technology Map Viewer
Quartus II Handbook Version 9.0 Volume 3: Verification © March 2009 Altera Corporation



Chapter 14: Design Debugging Using the SignalTap II Embedded Logic Analyzer 14–19
Configure the SignalTap II Embedded Logic Analyzer
Node List Signal Use Options
When a signal is added to the node list, you can select options that specify how the 
signal is used with the logic analyzer. You can turn off the ability of a signal to trigger 
the analyzer by disabling the Trigger Enable option for that signal in the node list in 
the .stp file. This option is useful when you want to see only the captured data for a 
signal and you are not using that signal as part of a trigger.

You can turn off the ability to view data for a signal by disabling the Data Enable 
column. This option is useful when you want to trigger on a signal, but have no 
interest in viewing data for that signal.

For information about using signals in the node list to create SignalTap II trigger 
conditions, refer to “Define Triggers” on page 14–33.

Untappable Signals 
Not all of the post-fitting signals in your design are available in the SignalTap II: 
post-fitting filter in the Node Finder dialog box. The following signal types cannot be 
tapped:

■ Post-fit output pins—You cannot tap a post-fit output pin directly. To make an 
output signal visible, tap the register or buffer that drives the output pin. This 
includes pins defined as bidirectional.

■ Signals that are part of a carry chain—You cannot tap the carry out (cout0 or 
cout1) signal of a logic element. Due to architectural restrictions, the carry out 
signal can only feed the carry in of another LE.

■ JTAG Signals—You cannot tap the JTAG control (TCK, TDI, TDO, and TMS) 
signals.

■ ALTGXB megafunction—You cannot directly tap any ports of an ALTGXB 
instantiation.

■ LVDS—You cannot tap the data output from a serializer/deserializer (SERDES) 
block.

■ DQ, DQS Signals—You cannot directly tap the DQ or DQS signals in a 
DDR/DDRII design. 

Adding Signals with a Plug-In
Instead of adding individual or grouped signals through the Node Finder, you can 
add groups of relevant signals of a particular type of IP through the use of a plug-in. 
The SignalTap II Embedded Logic Analyzer comes with one plug-in already installed 
for the Nios II processor. Besides easy signal addition, plug-ins also provide a number 
of other features, such as pre-designed mnemonic tables, useful for trigger creation 
and data viewing, as well as the ability to disassemble code in captured data.

The Nios II plug-in, for example, creates one mnemonic table in the Setup tab and two 
tables in the Data tab:

■ Nios II Instruction (Setup tab)—Capture all the required signals for triggering on 
a selected instruction address.

■ Nios II Instance Address (Data tab)—Display address of executed instructions in 
hexadecimal format or as a programming symbol name if defined in an optional 
Executable and Linking Format (.elf) file.
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■ Nios II Disassembly (Data tab)—Displays disassembled code from the 
corresponding address.

For information about the other features plug-ins provided, refer to “Define Triggers” 
on page 14–33 and “View, Analyze, and Use Captured Data” on page 14–66.

To add signals to the .stp file using a plug-in, perform the following steps after 
running Analysis and Elaboration on your design:

1. Right-click in the node list. On the Add Nodes with Plug-In submenu, click the 
name of the plug-in you want to use, such as the included plug-in named Nios II.

1 If the IP for the selected plug-in does not exist in your design, a message 
appears informing you that you cannot use the selected plug-in.

2. The Select Hierarchy Level dialog box appears showing the IP hierarchy of your 
design (Figure 14–9). Select the IP that contains the signals you want to monitor 
with the plug-in and click OK.

3. If all the signals in the plug-in are available, a dialog box might appear, depending 
on the plug-in selected, where you can set any available options for the plug-in. 
With the Nios II plug-in, you can optionally select an .elf file containing program 
symbols from your Nios II Integrated Development Environment (IDE) software 
design. Set options for the selected plug-in as desired and click OK.

1 To make sure all the required signals are available, in the Quartus II Analysis & 
Synthesis settings, turn on the Create debugging nodes for IP cores option.

All the signals included in the plug-in are added to the node list.

Adding Finite State Machine State Encoding Registers
Finding the signals to debug Finite State Machines (FSM) can be challenging. Finding 
nodes from the post-fit netlist may be impossible, as FSM encoding signals may be 
changed or optimized away during synthesis and place-and-route. If you are able to 
find all of the relevant nodes in the post-fit netlist or you used the nodes from the 
pre-synthesis netlist, an additional step is required to find and map FSM signal values 
to the state names that you specified in your HDL. 

Figure 14–9. IP Hierarchy Selection 
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Beginning with Quartus II software version 8.0, the SignalTap II GUI can detect FSMs 
in your compiled design. The SignalTap II configuration automatically tracks the FSM 
state signals as well as state encoding through the compilation process. Right-click 
dialog boxes from the SignalTap II GUI allow you to add all of the FSM state signals 
to your embedded logic analyzer with a single command. For each FSM added to 
your SignalTap II configuration, the FSM debugging feature adds a mnemonic table 
to map the signal values to the state enumeration that you provided in your source 
code. The mnemonic tables enable you to visualize state machine transitions in the 
waveform viewer easily. The FSM debugging feature supports adding FSM signals 
from both the pre-synthesis and post-fit netlists.

Figure 14–10 shows the waveform viewer with decoded signal values from a state 
machine added with the FSM debugging feature.

f For coding guidelines for specifying FSM in Verilog and VHDL, refer to the 
Recommended HDL Coding Styles chapter in volume 1 of the Quartus II Handbook.

To add pre-synthesis FSM signals to the configuration file, perform the following 
steps after running Analysis and Elaboration on your design:

1. Create a new .stp file or use an existing .stp file. 

1 Any .stp files that the MegaWizard Plug-In Manager creates from 
instantiations are not supported for this feature.

2. In the SignalTap II setup tab, right-click anywhere on the node list and select Add 
State Machine Nodes. The Add State Machine Nodes dialog box appears. This 
dialog box lists all the FSMs that have been found in your design. 

1 For the SignalTap II GUI to detect pre-synthesis state-machine signals, 
perform Analysis and Elaboration of your design.

3. From the Netlist pull-down menu, select Pre-Synthesis.

4. Select the desired FSM.

5. Click OK. This adds the FSM nodes to the configuration file. A mnemonic table is 
automatically applied to the FSM signal group.

To add post-fit FSM signals to the configuration file, perform the following steps after 
performing a full compile of your design:

1. Set the design partition of the FSM that you want to debug to post-fit.

2. Enable the .stp file for the Quartus II project using the SignalTap II Embedded 
Logic Analyzer page of the Settings dialog box. You can either create a new .stp 
file or use an existing .stp file. 

Figure 14–10. Decoded FSM Mnemonics
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1 For the SignalTap II GUI to detect post-fit state-machine signals, perform a 
full compile of your design.

3. In the SignalTap II setup tab, right-click anywhere on the node list and select Add 
State Machine Nodes. The Add State Machine Nodes dialog box appears. This 
dialog box lists all the FSMs that have been found in your design. 

4. From the Netlist pull-down menu, select Post-Fit.

5. Select the desired FSM.

6. Click OK. This adds the FSM nodes to the configuration file. A mnemonic table is 
automatically applied to the FSM signal group.

Modifying and Restoring Mnemonic Tables for State Machines
When you add FSM state signals via the FSM debugging feature, the SignalTap II GUI 
creates a mnemonic table using the format <StateSignalName>_table, where 
StateSignalName is the name of the state signals that you have declared in your RTL. 
You can edit any mnemonic table using the Mnemonic Table Setup dialog box. 

If you want to restore a mnemonic table that was modified, right-click anywhere in 
the node list window and select Recreate State Machine Mnemonics. By default, 
restoring a mnemonic table overwrites the existing mnemonic table that you 
modified. If you would like to restore a FSM mnemonic table to a new record, 
uncheck the Overwrite existing mnemonic table option in the Recreate State 
Machine Mnemonics dialog box. 

1 If you have added or deleted a signal from the FSM state signal group from within the 
setup tab, delete the modified register group and add the FSM signals back again. 

For more information about using Mnemonics, refer to “Creating Mnemonics for Bit 
Patterns” on page 14–69.

Additional Considerations
The SignalTap II configuration GUI recognizes state machines from your design only 
if you use Quartus II Integrated Synthesis (QIS). The state machine debugging feature 
is not able to track the FSM signals or state encoding if you have used a third-party 
synthesis tool.

If you are adding post-fit FSM signals, the SignalTap II FSM debug feature may not be 
able to track all of the optimization changes that are a part of the compilation process. 
If the following two specific optimizations are enabled, the SignalTap II FSM debug 
feature may not list mnemonic tables for state machines in the design:

■ If you have physical synthesis turned on, state registers may be resource balanced 
(register retiming) to improve fMAX. The FSM debug feature does not list post-fit 
FSM state registers if register retiming occurs. 

■ The FSM debugging feature does not list state signals that have been packed into 
RAM and DSP blocks during QIS or Fitter optimizations. 

You are still able to use the FSM debugging feature to add pre-synthesis state signals.
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Specifying the Sample Depth
The sample depth specifies the number of samples that are captured and stored for 
each signal in the captured data buffer. To set the sample depth, select the desired 
number of samples to store in the Sample Depth list. The sample depth ranges from 
0 to 128K.

If device memory resources are limited, you may not be able to successfully compile 
your design with the sample buffer size you have selected. Try reducing the sample 
depth to reduce resource usage.

Capturing Data to a Specific RAM Type
When you use the SignalTap II Embedded Logic Analyzer with some devices, you 
have the option to select the RAM type where acquisition data is stored. RAM 
selection allows you to preserve a specific memory block for your design and allocate 
another portion of memory for SignalTap II data acquisition. For example, if your 
design implements a large buffering application such as a system cache, it is ideal to 
place this application into M-RAM blocks so that the remaining M512 or M4K blocks 
are used for SignalTap II data acquisition.

To select the RAM type to use for the SignalTap II buffer, select it from the RAM type 
list. Use this feature when the acquired data (as reported by the SignalTap II resource 
estimator) is not larger than the available memory of the memory type that you have 
selected in the FPGA.

Choosing the Buffer Acquisition Mode
The Buffer Acquisition Type Selection feature in the SignalTap II Embedded Logic 
Analyzer lets you choose how the captured data buffer is organized and can 
potentially reduce the amount of memory that is required for SignalTap II data 
acquisition. There are two types of acquisition buffer within the SignalTap II 
Embedded Logic Analyzer—a non-segmented buffer and a segmented buffer. With a 
non-segmented buffer, the SignalTap II Embedded Logic Analyzer treats entire 
memory space as a single FIFO, continuously filling the buffer until the embedded 
logic analyzer reaches a defined set of trigger conditions. With a segmented buffer, 
the memory space is split into a number of separate buffers. Each buffer acts as a 
separate FIFO with its own set of trigger conditions. Only a single buffer is active 
during an acquisition. The SignalTap II Embedded Logic Analyzer advances to the 
next segment after the trigger condition or conditions for the active segment has been 
reached.

When using a non-segmented buffer, you can use the storage qualification feature to 
determine which samples are written into the acquisition buffer. Both the segmented 
buffers and the non-segmented buffer with the storage qualification feature help you 
maximize the use of the available memory space. Figure 14–11 illustrates the 
differences between the two buffer types.
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For more information about the storage qualification feature, refer to “Using the 
Storage Qualifier Feature” on page 14–25.

Non-Segmented Buffer
The non-segmented buffer (also known as a circular buffer) shown in Figure 14–11 (a) 
is the default buffer type used by the SignalTap II Embedded Logic Analyzer. While 
the logic analyzer is running, data is stored in the buffer until it fills up, at which point 
new data replaces the oldest data. This continues until a specified trigger event—that 
is, a set of trigger conditions—occurs. When this happens, the logic analyzer 
continues to capture data after the trigger event until the buffer is full, based on the 
trigger position setting in the Signal Configuration pane in the .stp file. Select a 
setting from the list to choose whether to capture the majority of the data before (Post 
trigger position), after (Pre-trigger position) the trigger occurs, or to center the 
trigger position in the data (Center trigger position). Alternatively, use the custom 
State-based triggering flow to define a custom trigger position within the capture 
buffer. 

For more information, refer to “Specifying the Trigger Position” on page 14–48.

Segmented Buffer
A segmented buffer makes it easier to debug systems that contain relatively 
infrequent recurring events. The acquisition memory is split into a set of evenly sized 
segments, with a set of trigger conditions defined for each segment. Each segment acts 
as a non-segmented buffer. Figure 14–12 shows an example of this type of buffer 
system.

Figure 14–11. Buffer Type Comparison in the SignalTap II Embedded Logic Analyzer (Note 1)

Note to Figure 14–11:
(1) Both non-segmented and segmented buffers can use a predefined trigger (Pre-Trigger, Center Trigger, Post-Trigger) position or define a custom 

trigger position using the State-Based Triggering tab. Refer to “Specifying the Trigger Position” on page 14–48 for more details.
(2) Each segment is treated like a FIFO, and behaves as the non-segmented buffer shown in (a).
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The SignalTap II Embedded Logic Analyzer verifies the functionality of the design 
shown in Figure 14–12 to ensure that the correct data is written to the SRAM 
controller. Buffer acquisition in the SignalTap II Embedded Logic Analyzer allows you 
to monitor the RDATA port when H'0F0F0F0F is sent into the RADDR port. You can 
monitor multiple read transactions from the SRAM device without running the 
SignalTap II Embedded Logic Analyzer again. The buffer acquisition feature allows 
you to segment the memory so you can capture the same event multiple times 
without wasting allocated memory. The number of cycles that are captured depends 
on the number of segments specified under the Data settings.

To enable and configure buffer acquisition, select Segmented in the SignalTap II 
Editor and select the number of segments to use. In the example, selecting sixty-four 
64-sample segments allows you to capture 64 read cycles when the RADDR signal is 
H'0F0F0F0F.

f For more information about buffer acquisition mode, refer to Setting the Buffer 
Acquisition Mode in the Quartus II Help.

Using the Storage Qualifier Feature
Both non-segmented and segmented buffers described in the previous section offer a 
snapshot in time of the data stream being analyzed. The default behavior for writing 
into acquisition memory with the SignalTap II Embedded Logic Analyzer is to sample 
data on every clock cycle. With a non-segmented buffer, there is one data window 
that represents a contiguous snapshot of the datastream. Similarly, segmented buffers 
use several smaller sampling windows spread out over a larger time scale, with each 
sampling window representing a contiguous data set.

With carefully chosen trigger conditions and a generous sample depth for the 
acquisition buffer, analysis using segmented and non-segmented buffers captures a 
majority of functional errors in a chosen signal set. However, each data window can 
have a considerable amount of redundancy associated with it; for example, a capture 
of a data stream containing long periods of idle signals between data bursts. With 
default behavior using the SignalTap II Embedded Logic Analyzer, there is no way to 
discard the redundant sample bits.

Figure 14–12. Example System that Generates Recurring Events
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The Storage Qualification feature allows you to filter out individual samples not 
relevant to debugging the design. With this feature, a condition acts as a write enable 
to the buffer each clock cycle during a data acquisition. Through fine tuning the data 
that is actually stored in acquisition memory, the Storage Qualification feature allows 
for a more efficient use of acquisition memory and covers a larger time scale. 

Use of the Storage Qualification feature is similar to an acquisition using a segmented 
buffer, in that you can create a discontinuity in the capture buffer. Because you can 
create a discontinuity between any two samples in the buffer, the Storage 
Qualification feature is equivalent to being able to create a customized segmented 
buffer in which the number and size of segment boundaries are adjustable. 
Figure 14–13 illustrates three ways the SignalTap II Embedded Logic Analyzer writes 
into acquisition memory.

1 The Storage Qualification feature can only be used with a non-segmented buffer. The 
MegaWizard Plug-In Manager instantiated flow only supports the Input Port mode 
for the Storage Qualification feature.

Figure 14–13. Data Acquisition Using Different Modes of Controlling the Acquisition Buffer

Notes to Figure 14–13:

(1) Non-segmented Buffers capture a fixed sample window of contiguous data.
(2) Segmented buffers divide the buffer into fixed sized segments, with each segment having an equal sample depth.
(3) Storage Qualification allows you to define a custom sampling window for each segment you create with a qualifying condition. Storage 

qualification potentially allows for a larger time scale of coverage.
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There are five types available under the Storage Qualification feature: 

■ Continuous

■ Input port 

■ Transitional

■ Conditional

■ Start/Stop

■ State-based

Continuous (the default mode selected) turns the Storage Qualification feature off.

Each selected storage qualifier type is active when an acquisition starts. Upon the start 
of an acquisition, the SignalTap II Embedded Logic Analyzer examines each clock 
cycle and writes the data into the acquisition buffer based upon storage qualifier type 
and condition. The acquisition stops when a defined set of trigger conditions occur. 

1 Trigger conditions are evaluated independently of storage qualifier conditions. The 
SignalTap II Embedded Logic Analyzer evaluates the data stream for trigger 
conditions on every clock cycle after the acquisition begins.

Trigger conditions are defined in “Define Trigger Conditions” on page 14–6.

The storage qualifier operates independently of the trigger conditions. 

The following subsections describe each storage qualification mode from the 
acquisition buffer. 

Input Port Mode
When using the Input port mode, the SignalTap II Embedded Logic Analyzer takes 
any signal from your design as an input. When the design is running, if the signal is 
high on the clock edge, the SignalTap II Embedded Logic Analyzer stores the data in 
the buffer. If the signal is low on the clock edge, the data sample is ignored. A pin is 
created and connected to this input port by default if no internal node is specified. 

If you are using an .stp file to create a SignalTap II Embedded Logic Analyzer 
instance, specify the storage qualifier signal using the input port field located on the 
Setup tab. This port must be specified for your project to compile. 

If you are using the MegaWizard Plug-In Manager flow, the storage qualification 
input port, if specified, will appear in the MegaWizard-generated instantiation 
template. This port can then be connected to a signal in your RTL.

Figure 14–14 shows a data pattern captured with a segmented buffer. Figure 14–15 
shows a capture of the same data pattern with the storage qualification feature 
enabled.

Figure 14–14. Data Acquisition of a Recurring Data Pattern in Continuous Capture Mode (to illustrate Input port mode)
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Transitional Mode
In Transitional mode, you choose a set of signals for inspection using the node list 
check boxes in the storage qualifier column. During acquisition, if any of the signals 
marked for inspection have changed since the previous clock cycle, new data is 
written to the acquisition buffer. If none of the signals marked have changed since the 
previous clock cycle, no data is stored. Figure 14–16 shows the transitional storage 
qualifier setup. Figure 14–17 and Figure 14–18 show captures of a data pattern in 
continuous capture mode and a data pattern using the Transitional mode for storage 
qualification.

Figure 14–15. Data Acquisition of a Recurring Data Pattern Using an Input Signal as a Storage Qualifier

Figure 14–16. Transitional Storage Qualifier Setup

Figure 14–17. Data Acquisition of a Recurring Data Pattern in Continuous Capture Mode (to illustrate 
Transitional mode)

Figure 14–18. Data Acquisition of Recurring Data Pattern Using a Transitional Mode as a Storage 
Qualifier 
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